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Google Mail  

 

 

Custom Apps logo โลโกท้ีอ่ัพโหลดโดย 
admin 

Compose Mail ส าหรับการเขยีนเมลใ์หม ่

Inbox ส าหรับเชค็อเีมล ์ (เลขทีอ่ยูใ่นวงเล็บนัน้
หมายถงึวา่มขีอ้ความจ านวนเทา่ใดทีค่ณุยงัไมไ่ด ้
เปิดอา่น) 

Starred ไวโ้ชวข์อ้ความทีค่ณุตอ้งการใหม้ันส าคัญ 

Chats แสดงรายชือ่ส าหรับแชท็ 

Sent Mail กลอ่งขอ้ความทีส่ง่ออกไป  

Drafts ขอ้ความทีค่ณุรา่งไวจ้ะถกูเก็บบันทกึไวท้ีน่ี่  

Spam เป็นเมลท์ีไ่มน่่าไวว้างใจ 

Trash เมลท์ีค่ณุลบทิง้จะไปอยูท่ีน่ี่ คณุสามารถลา้ง
ขอ้ความทีน่ี่เมือ่ใดกไ็ด ้ 

Custom labels ใชใ้นการแบง่ประเภทของอเีมล์

ตามทีค่ณุตอ้งการ (ตัวเลขในวงเล็บจะหมายถงึ
ขอ้ความทีค่ณุยงัไมไ่ดอ้า่น)  

Contacts เป็นลสิตข์องอเีมลท์ีค่ณุเคยตดิตอ่ 

Tasks ไวส้ าหรับการสรา้ง Things to do lists  
 

Apps mail labs 

เป็นฟีเจอรท์ีท่าง Google ไดท้ดลองปลอ่ยเวอรช์ัน่ beta ออกมาเพือ่ทดลองใชง้านฟร ี

โดยสามารถสง่ feedback กลับไดเ้พือ่รายงานความผดิพลาดตา่งๆได ้

ตัวอยา่ง Apps mail labs 

- Canned responses เป็นตัวอยา่งฟีเจอรท์ีต่อบโจทยส์ าหรับ คนทีต่อ้งตอบเมลร์ปู
แบบเดมิซ ้าๆ ซึง่เราสามารถบันทกึขอ้ความเหลา่นัน้ไวเ้ป็น pattern ส าหรับใชไ้ด ้

 

1. เขยีนเมลใ์หมข่ ึน้มา (ส าหรับไฟลร์ปูภาพไมส่ามารถท าได)้ 
2. หลังจากเขยีนขอ้มลูทีต่อ้งการสรา้งเป็น template เสร็จแลว้ คลกิ “New 

Canned Response” ใตห้ัวขอ้ Save 
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3. พมิพช์ือ่ของอเีมล ์Template แลว้คลกิ “OK.” 

 

4. ตอนนี ้email template ก็พรอ้มใชง้านใน canned responses แลว้ 

 

หมายเหต;ุ email template ไมส่ามารถบันทกึในขอ้มลู ‘To:’ หรอื ‘Subject:’ ขอ้มลูที่
สามารถบันทกึไดม้เีฉพาะกลอ่งขอ้ความเทา่นัน้ 

คณุสามารถใช ้Email template ในการสรา้งเมลใ์หมห่รอื forward mail โดยมขีัน้ตอ้น
ดังนี ้

1. เขยีน e-mail ใหม ่
2. ไปยัง Canned responses 

3. ขา้งลา่งหัวขอ้ Insert เลอืก email template ทีต่อ้งการเลอืกใช ้
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4. หลังจากนัน้ email template ก็จะแสดงขึน้มาใน message box 

การแกไ้ขขอ้มลูใน email template ท าได ้2 วธิคีอื 

1. เขยีนเมลใ์หมแ่ลว้ insert canned response 

หรอื สรา้งเมลใ์หมแ่ละพมิพข์อ้มลูใหมท่ัง้หมด 

2. แกไ้ขจนเป็นทีพ่อใจ 

3. ไปยังเมนู Canned response เลอืกคลกิที ่email template เดมิใตห้ัวขอ้ Save 
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- Undo เป็นฟีเจอรส์ าหรับคนทีช่อบเผลอไปกดโดนปุ่ ม send หรอืดันสง่เมลห์รอืไฟลผ์ดิ 
โดยเราสามารถ undo ได ้แตม่ขีอ้แมอ้ยูว่า่เราตอ้งรูต้ัวภายในไมก่ีว่นิาท ี

 

  

 

ส าหรับการตดิตัง้ App mail labs สามารถท าไดโ้ดย คลกิที ่Settings>Labs>คน้หา 
feature ทีต่อ้งการ>Enables 

 

 

 

 

 

 

 

 

 

 

 



Copyright © 2012 by Google Apps Supporting Program  Page 9 
 

การสง่และรบัเมล ์

เขยีนและสง่ขอ้ความ 

 

 เริม่จากการกรอก e-mail address ของผูรั้บ 

 

Tip; เราสามารถกดตรง To เพือ่เลอืกรายชือ่ทีต่อ้งการสง่ได ้

 

จากนัน้พมิพข์อ้ความแลว้กดสง่ 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/contacts autocomplete.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/Choose from contacts.png?attredirects=0
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Tip; 

Add CC  

 

E-mail ทีก่รอกอยูใ่นชอ่ง Cc จะไดรั้บขอ้ความเหมอืนกับในชอ่ง To ทกุประการ แตจ่ะมจีุดที่

แตกตา่งกัน คอื ผูรั้บไมจ่ าเป็นตอ้งตอบกลับ เพราะ E-mail ฉบับนี้เป็นเพยีงแคส่ าเนาทีต่อ้งการ
แจง้ใหท้ราบเพยีงเทา่นัน้ 

Add BCC 

 

E-mail ทีก่รอกอยูใ่นชอ่ง Bcc จะไดรั้บขอ้ความทีเ่หมอืนกับในชอ่ง To และ Cc ทกุประการ แต่
จะมจีุดพเิศษและไมเ่หมอืนอยูท่ี ่ผูรั้บในชอ่ง To และ Cc จะไมเ่หน็ E-mail ในชอ่งนี ้

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/compose message send.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-2/cc link.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-2/bcc link.png?attredirects=0
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Format Email  

 

เป็นการเซต็รปูแบบของขอ้ความทีพ่มิพ ์ 

Paint Text เป็นการยอ่หนา้ตา่งของ Format email toolbar เขา้ไป 

 

Rich Text เป็นการขาย Format email toolbar ออก 

Google Mail's Formatting Options 

 

Bold – ท าตัวหนาบางสว่น หรอืทัง้หมด 

 

Italics – ท าตัวเอยีงบางสว่น หรอืทัง้หมด 

 

Underline – ขดีเสน้ใตบ้างสว่น หรอืทัง้หมด 

 

Font – เลอืกเปลีย่นรปูแบบตัวอักษร 

 

Font Size – เปลีย่นขนาดของตัวอักษรบางสว่นหรอื
ทัง้หมด 

 

Font Color – เปลีย่นสขีองขอ้ความบางสว่น หรอื
ทัง้หมด 

 

Highlight Color – เนน้ขอ้ความดว้ยสตีา่งๆ 

 

Remove Formatting - ลบรปูแบบออกจาก

ขอ้ความทีเ่ลอืก 

 

Hyperlink Text – ท า hyperlink กับขอ้ความทีเ่ลอืก 

 

Numbered List – สรา้ง list number ในขอ้ความ 

 

Bulleted List – สรา้ง bulleted list ในขอ้ความ 

 

Indent Less – ยา้ยขอ้ความเขา้มาใกลท้างซา้ย 

 

Indent More – ยา้ยขอ้ความเขา้ไปทางขวามากขึน้ 

 

Quote Text – ใสข่อ้ความในรปูแบบของ quote 

 

Left Align – จัดขอ้ความชดิซา้ยของหนา้ 

 

Center Align – จัดขอ้ความใหอ้ยูต่รงกลางหนา้ 

 

Right Align – จัดขอ้ความใหช้ดิขวาของหนา้ 

 

Right to left* - เปลีย่นทศิทางของต าแหน่ง
ขอ้ความไปทางซา้ย 

 

Left to right* - เปลีย่นทศิทางของต าแหน่ง

ขอ้ความไปทางขวา 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-3/formatting options.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-3/rich formatting links.png?attredirects=0
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การแนบไฟล ์

1.คลกิ attach a file 

 

2.หนา้ตา่ง Browse show ขึน้มาใหเ้ลอืกไฟล ์เราสามารถเลอืกไฟลไ์ดห้ลาย file โดยใช ้Shift 
หรอื Ctrl 

 

3.กด open ระบบจะท าการ upload files 

 

นอกจากนัน้เรายังสามารถเพิม่ไฟลท์ีต่อ้งการได ้ตรง Attach another file 

ตวัอยา่ง  

 ถา้คณุเขยีน email แลว้พมิพว์า่ "Hi Mike, I'm attaching the latest reports" 

แลว้คลกิ send แตค่ณุไมไ่ดแ้นบไฟลใ์ดเลย Gmail จะท าการเตอืนคณุดว้ยpopup 
ขา้งลา่งนี ้

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-4/attach file link.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-4/choose files.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-4/attach files.png?attredirects=0
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การ Save Draft  

 ไมต่อ้งกังวลเรือ่งขอ้มลูหายเพราะ Apps mail จะท าการบันทกึรา่งเมลไ์วภ้าย

ไมก่ีว่นิาท ีหรอืหากคณุตอ้งการบันทกึ draft เพยีงแคก่ด Ctrl+S (Cmd+S for 
Macintosh users) 

 

 

ถา้คณุออกจาก drafted คณุสามารถดหูรอืแกไ้ขอกีครัง้หนึง่ดังนี้ 

1. คลกิ Drafts 

 

2. คลกิเลอืกเมลท์ีค่ณุตอ้งการเขยีนเมลต์อ่ 

3. เลอืก Edit the message หลังจากนัน้สามารถ Send, Save Changes หรอื Discard 

แตห่ากวา่คณุไมต่อ้งการ draft นัน้แลว้ เพยีงท าตามดังนี ้

1. คลกิ Draft  
2. เลอืก draft ทีต่อ้งการลบ 

3. คลกิเลอืก discard drafts 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-5/autosaved drafts.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/1-5/discard drafts-1.png?attredirects=0
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การจดักลุม่อเีมลโ์ดยบทสนทนา 

 คณุเคยเจอหรอืไมท่ีบ่างครัง้ เมลท์ีส่ง่มามคีวามเกีย่วขอ้งหรอืพดูถงึเรือ่งเดยีวกนั แต่

กลับสง่แยกออกมาเป็นเมลห์ลายฉบบัตามภาพดา้นลา่ง 

 

App mail groups จะตอบเมลก์ลบัเป็นลักษณะ conversation หรอืบทสนทนา ท าใหเ้ขา้ใจง่าย 

 

 เมลใ์นลักษณะบทสนทนา คอื แตล่ะขอ้ความจะแสดงออกเป็นกองซอ้นกัน เมลท์ีอ่ยู่

บนสดุเป็นเมลท์ีส่ง่มาแรกสดุ สว่นเมลท์ีใ่หมส่ดุจะแสดงใหค้ณุเหน็กอ่นเสมอดังภาพ และถา้
หากสง่มาจากหลายคนชือ่เมลก์จ็ะมสีทีีแ่ตกตา่งกันดว้ย 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/2-1/inbox view conversations.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-1/2-1/conversation view.png?attredirects=0
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 ถา้คณุตอ้งการดขูอ้ความทัง้หมดในบทสนทนา เพยีงแคค่ลกิ Expand all แตห่าก
ตอ้งการดแูคข่อ้ความใดขอ้ความหนึง่ทีก่องซอ้นกนั เพยีงแคค่ลกิกด ขอ้ความนัน้ก็จะขยาย

ออกมา และหากตอ้งการปิดก็เพยีงแคก่ดตรงขอ้ความนัน้อกีครัง้หนึง่ 

 

 

 

และหากตอ้งการ Forward อเีมลแ์บบสนทนาทัง้หมดก็เพยีงแคเ่ลอืก forward all 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/2-2/single message conversation.png?attredirects=0
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ตัวอยา่ง mail ทีม่กีารแนบไฟล ์

 

การตอบเมล ์

 เราสามารถตอบได ้2 แบบคอื  

1. ตอบเฉพาะคนทีส่ง่เมล ์

2. ตอบเมลก์ลบัไปหาทกุคน 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/3-2/viewer1.png?attredirects=0
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หรอืจะเลอืก Forward mail ก็ได ้

 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/3-4/reply to message.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/3-5/forward a message.png?attredirects=0
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การ Print mail (เฉพาะบทสนทนาน ัน้) 

 

คลกิ More>print 

 

อเีมลจ์ากหลาย account เขา้ inbox  

 

ตัง้คา่โดยไปที ่Setting>accounts>add a mail account you own 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/3-6/print message.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/5-1/multiple accounts.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/5-2/add pop3 mail account.png?attredirects=0
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กรอก Email ทีต่อ้งการเพิม่ 

 

 เลอืก Send through Gmail เพือ่ให ้Gmail สง่ verify code ยันยันความเป็น
เจา้ของเมลนั์น้ 

 

 เลอืก Send verification 

 

 หลังจากนัน้ใหน้ า Verify code จากเมลท์ีเ่ราตอ้งการเพิม่มาใสแ่ลว้กด verify 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/5-2/pop3 email address.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/5-2/pop3 options.png?attredirects=0
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การเพิม่ Signature 
เป็นการเพิม่ลายเซน็ หรอืลงชือ่ไวย้ังตอนทา้ยของเมลโ์ดยอัตโนมตั ิโดยสามารถเลอืก

ใหส้ว่นนี้ท างานไดโ้ดย Setting>General>Signature> แลว้กรอก Signature ทีค่ณุตอ้งการ

ลงไป 

 
 

Vacation responder 
  

หากวา่เราอยูใ่นชว่งพักรอ้น พักผ่อน หรอืจะไมส่ามารถใชอ้นิเตอรเ์น็ตได ้เราสามารถตัง้
คา่ให ้Google Apps mail vacation responder บอกกับผูอ้ ืน่รูว้า่เราไมส่ามารถตอบเมลไ์ด ้

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-3/confirmation email-1.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-1/email signature.png?attredirects=0
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วธิกีารตัง้คา่ Google Apps mail vacation responder 

1. Sign in ไปยัง App mail account 
2. เลอืก Setting 

 

3. จาก general tab, เลอืก vocation responder on  

 

4. กรอกหัวขอ้(Subject) และขอ้ความ (Message) 
5. หากตอ้งการบอกใหเ้ฉพาะคนทีอ่ยูใ่นรายชือ่ตดิตอ่คณุสามารถเลอืกตรง only send 

a response to people in my Contacts แตห่ากคณุไมเ่ลอืกคนทกุคนทีส่ง่เมลถ์งึ

คณุก็จะไดรั้บ auto-response นี้ 
6. คลกิ save changes  

การ Enable vacation time  

 วธิกีารตัง้คา่ Setting>Lab>Vacation Time>Enable 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-2/Vacation responder message.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-2/Vacation Responder Settings-1.png?attredirects=0
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 ตัวอยา่งหนา้ตาของ Vacation responder ที ่Enable vacation time แลว้ 

 

Chatting and Talk  

1. ตรงชอ่ง Search, chat, or SMS 

 

 

2. กรอกเมลผ์ูท้ีต่อ้ง invite to chat 

 

3. เลอืกตรง Profile > Invite to chat 

4. หลังจากนัน้ผูท้ีถ่กู Invite จะตอ้งตอบตกลงถงึจะแชท็กันได ้

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-2/Vacation Time lab-1.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-2/6-2/Vacation responder pick dates-1.png?attredirects=0
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การสง่ SMS  

1. ตรงชอ่ง Search, chat, or SMS 

2. กรอกเมลผ์ูท้ ีต่อ้งการสง่ SMS 
3. เลอืก Send SMS 

4. กรอกหมายเลขโทรศัพทพ์รอ้มระบปุระเทศ 

 

หมายเหต ุ

 

 

 ส าหรับการใชง้านที ่Google ให ้credit ไวแ้ค ่50 ครัง้หมายความวา่ หากคณุสง่ SMS 
ออกไปแลว้มกีารตอบกลบั Credit ของคณุก็ยงัคงมเีทา่เดมิ (คอืคงเหลอื 50 ครัง้) แตห่ากคณุ

สง่ไปแตไ่มม่กีารตอบกลบั credit ของคณุก็จะลดลง เหลอืแค ่49 ครัง้เป็นตน้ 
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 +++ ขอ้ดขีอง SMS นี้คอืชว่ยใหค้ณุตดิตอ่กบัคนในทมีงานที ่offline อยูไ่ดอ้ยา่งมี
ประสทิธภิาพมากยิง่ข ึน้ และยังชว่ยประหยัดคา่ใชจ้่ายอกีดว้ย 

 

  

จดัการและจดัเก็บอเีมล ์ 

● การใช ้labels เพือ่จดัการกบัอเีมล ์ 

ใน Google App Mail เราใช ้Labels ในการจัดการกับเมลแ์ทนการใช ้Folders 

ท าไมถงึใช ่Labels ไมใ่ช ่folders? 

เพราะถา้เราเก็บเมลเ์ป็นโฟลเดอร ์ก็เหมอืนกับแคเ่ราแยกเมลเ์ป็นกองๆ ลองนกึดเูลน่ๆ 
วา่ถา้เกดิเมลท์ีก่องๆ อยูนั่น้เป็นเมลต์อบกลับ เมลท์ี ่forward มาบา้ง แตเ่ป็นเรือ่งทสีมัพันธก์ัน 

หมายความวา่เราตอ้งมาน่ังคัดกรองเมลเ์อง 

แตถ่า้เป็น Labels คอืสิง่ทีท่ าไดเ้หมอืน folder ทกุอยา่งทีต่า่งกนัตรงทีว่า่ Google App 

Mail มลีักษณะการสง่เมลเ์ป็นแบบ conversation หรอืบทสนทนา ซึง่หมายความวา่ เพยีงแค่
เรา แยกเมลนั์น้เมลเ์ดยีวลง Label ใด Label หนึง่ ทกุ conservation ทีเ่กีย่วกบัเมลนั์น้จะเก็บไว ้
ใน Label ทันท ี

 

เพือ่ใหเ้ห็นความแตกตา่งของ Labels และ Folders ชดัเจนขึน้สามารถอา่นตาราง
ดา้นลา่งนี ้

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-4/labeled conversation.png?attredirects=0
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Labels Folders 

หนึง่ Conversation สามารถมไีดม้ากกวา่หนึง่ 

Label 

คณุสามารถใสไ่ดเ้ฉพาะหนึง่ขอ้ความตอ่หนึง่ 

Folder เทา่นัน้ 

หนึง่ Conversation สามารถมไีดห้ลาย 

locations (ทัง้ Inbox, All mail, Sent Mail, 

etc.) ซึง่ท าใหง้่ายตอ่การหาในภายหลัง 

คณุตอ้งจ าวา่คณุเกบ็เมลนั์น้ไวใ้น Folder ไหน 

คณุสามารถคน้หา Conversation ดว้ย Label คณุไมส่ามารถคน้หาโดยระบ ุFolder นัน้ๆได ้

ถงึแมว้า่คณุลบ label นัน้ทิง้ เมลท์ีเ่กีย่วขอ้งก็ยังอยูไ่มห่ายไปไหน 

 

Default Labels 
 

 โดยปกตแิลว้ Apps mail ม ีLabels ทีส่รา้งขึน้อัตโนมัตอิยูแ่ลว้ดงันี้ 

1. Inbox เป็น label ทีแ่สดง conversations (ซึง่ตัวเลขที่

แสดงในวงเล็บหมายถงึจ านวน เมลท์ีค่ณุยงัไมไ่ดอ้า่น). 
2. Starred label นี้จะแสดงเฉพาะขอ้ความทีค่ณุไดท้ า

สญัลักษณ์รปูดาวเอาไว ้ซึง่การใหด้าวคอืการใหค้วามส าคัญกับ 

conversations หรอื ขอ้ความ หรอืใชเ้พือ่เป็นเครือ่งหมายเตอืนให ้
รูว้า่คณุตอ้งการตดิตามขอ้ความ หรอื Conversation นัน้ใน
ภายหลัง 

 
 **การเพิม่สญัลักษณ์รปูดาวท าไดโ้ดยคลกิ "star" บน
หนา้ขอ้ความ  

 
 

3. Chats เป็น label ทีเ่ก็บรายชือ่ผูต้ดิตอ่ 
4. Sent Mail เป็น label ทีเ่ก็บขอ้ความทีค่ณุออกไป. 

5. Drafts เป็น label ส าหรับเก็บรา่งเมล ์
6. All Mail เป็น label ส าหรับเก็บเมลท์ัง้หมด ทัง้กลอ่งขาเขา้ กลอ่งขาออก 
7. Spam เป็น label ทีเ่ก็บเมลท์ีส่ง่เขา้มาแลว้สงสยัวา่เป็นเมลไ์มน่่าไวว้างใจ 

8. Trash เป็น label ทีเ่กบ็ขอ้ความทีค่ณุไดล้บไปแลว้ คณุสามารถท าให ้label นี้วา่งได ้
หากคณุตอ้งการ 

การสรา้งหรอืแกไ้ข Labels 

1. เปิดเมลท์ีต่อ้งการสรา้ง label เลอืก label > create new 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-4/1-3/labels list.png?attredirects=0
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2. ใสช่ือ่ label ใหมแ่ลว้กด create 

 

 

 

3. หากตอ้งการแกไ้ขขอ้มลูของ label ดตูรงหัวเมลท์ีม่สีญัลักษณ์ label คลกิหนึง่ครัง้แคน่ี้
เราก็สามารถก าหนดสขีอง label เปลีย่นชือ่ ปิดการแสดง label นี้ หรอืลบทิง้เลยก็ได ้  
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การใช ้filter  

 

Filter ถา้แปลเป็นไทยตรงๆเลยคอื เครือ่งกรอง หรอืกระดาษกรอง 

แตถ่า้ส าหรับ Apps mail แลว้ Filter จะท าตามค าสั่งตามเกณฑท์ีค่ณุสรา้งขึน้ 

 
ท าไมถงึตอ้งม ีFilter แลว้ Filter ชว่ยอะไร?  

ลองนกึดเูลน่ๆวา่ หากเมลท์ีค่ณุรับมาจากหอ้งสมดุเพือ่เตอืนค าจ าคณุวา่คณุตอ้งคนื
หนังสอืภายในอกีสามวัน หนึง่เทอมคณุยมืไปกีเ่ลม่แลว้ตอ้งมเีมลแ์จง้เตอืนนี้เขา้มากีฉ่บับ 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-4/3-1/Filters - Settings - jeff@g1usd.org-1.png?attredirects=0
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 Filter จะชว่ยท าใหค้ณุสามารถรับมอืกับอเีมลท์ีค่ณุรูว้า่จะสง่มาโดยใคร หัวขอ้หรอื
เนื้อหาแบบไหน แลว้จะท าไหนกบัมัน พอเหน็ภาพแลว้น่ะครับ เราลองมาสรา้ง Filter กันเลย 

 
1. คลกิตอ้ง Settings (บนมมุบนขวาของหนา้ Apps mail). 
2. คลกิ Filters 

3. คลกิ Create a filter  
 

 
 

4. กรอก filter criteria ทีค่ณุตอ้งการ ตัวอยา่งเชน่, 'Has the words: Newsletter'. 
 

 
 

5. คลกิ Test Search เพือ่ดวูา่มขีอ้ความไหนทีเ่ขา้กนักับ filter term ทีก่รอกลงไปหรอื
เปลา่ 

6. หลังจากนัน้ก็สรา้ง Filter (Create filter with this search) 
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7. เลอืกวา่ตอ้งการทีจ่ะท าอยา่งไรกับเมลน์ี ้ 
8. สมมตวิา่เราตอ้งใหท้กุขอ้ความทีเ่กีย่วกบั Newsletter ใหเ้กบ็ไปยัง label PR & 

Marketing เราก็คลกิเลอืกตรงชอ่ง Apply the label: > เลอืก Label Pr & Marketing 
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9. หลังจากนัน้เราสามารถเขา้ไปแกไ้ขหรอืลบ Filter นี้ไดใ้น Setting > Filters จะมปีุ่ มให ้
edit กับ delete อยู ่

 

 

การต ัง้ Forward mail ไปยงัเมลอ์ืน่  

 เป็นทางเลอืกส าหรับกรณีทีค่ณุมหีลายอเีมล ์การ Forward mail ไปยังเมลอ์ืน่จะชว่ยให ้

คณุสามารถจัดการกับทกุเมลไ์ดง้่ายขึน้ ซึง่วธิกีารตัง้คา่มดีังนี ้

1) คลกิ Settings บนมมุขวาบนหนา้Apps mail และเปิดไปยังหนา้แถบ Forwarding 

and POP/IMAP ดังภาพ 
 

 
 
 
 

 

https://mail.google.com/mail/#settings/fwdandpop
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2) เลอืก Add a forwarding address แลว้กรอกเมลท์ีต่อ้งการ Forward ลงไปแลว้กด 

Next 
 

 

 
3) หลังจากนัน้ใหน้ า verify code จากเมลท์ีเ่ราตอ้งการ forward mail ไปมาใส ่แลว้กด 

Verify 

 

 
 

4) หลังจากที ่Verify แลว้เราสามารถระบไุดว้า่ Forward mail ทีส่ง่ไปยงัเมลนั์น้ เราจะท า
อยา่งไรตอ่ด ี
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ระหวา่ง 
Keep mail’s copy in the inbox : เก็บเมลไ์วท้ี ่inbox หรอื 

Mark mail’s copy as read       :  ใหเ้กบ็เมลไ์ว ้และ ท าใหเ้ป็นอา่นแลว้ หรอื 
Archive mail’s copy               : ให ้archive เก็บไว ้หรอื 
Delete mail’s copy         : ให ้delete เมลนั์น้  

 
 
พอท าการตัง้คา่ทกุอยา่งเสร็จแลว้กก็ด Save Changes เป็นอันเสร็จเรยีบรอ้ย 

เคล็ดลบัการหาอเีมล ์

Operator Definition Example(s) 

from: 
ใชร้ะบคุนสง่เฉพาะเจาะจง Example - from:amy 

Meaning - ขอ้ความจาก Amy 

to: 

ใชร้ะบคุนรับเฉพาะเจาะจง Example - to:david 
Meaning – ทกุขอ้ความทีส่ง่ถงึ David  

subject: 
คน้หาค าในบรรทัด subject  Example - subject:dinner 

Meaning – ขอ้ความทีม่คี าวา่ 
"dinner" อยูใ่น subject 

OR 

คน้หาส าหรับขอ้ความทีเ่ขา้กนั

ระหวา่ง 2  
 

*OR จะตอ้งตัวใหญเ่ทา่นัน้ 

Example - from:amy OR 

from:david 
Meaning – ขอ้ความจาก Amy หรอื 
จาก David 

-  
(hyphen) 

ใชส้ าหรับลบค าทีไ่มต่อ้งการออกจาก

การคน้หา 

Example - dinner -movie 

Meaning – ขอ้ความทีม่คี าวา่ 
"dinner" แตไ่มม่คี าวา่ "movie" 

label: 

คน้หาขอ้ความดว้ย label* 

 
 
 

 
 

*ซึง่การคน้หานี้จะไมแ่สดง label ที่

ไมเ่กีย่วขอ้งกบัขอ้ความนี ้

Example - from:amy label:friends 

Meaning – ขอ้ความจาก Amy ทีอ่ยู่
ใน label "friends" 
Example - from:david label:my-

family 
Meaning – ขอ้ความจาก David ทีอ่ยู่
ใน label "My Family" 
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has:attachment 

คน้หาขอ้ความทีม่กีารแนบไฟล ์ Example - from:david 

has:attachment  
Meaning – ขอ้ความจาก David ทีม่ี
การแนบไฟล ์

list: 

คน้หาขอ้ความทีอ่ยูใ่นรายชือ่ผูต้ดิตอ่ Example - list:info@example.com  

Meaning – ขอ้ความทีม่คี าวา่ 
info@example.com อยูใ่น headers, 
sent to หรอื from รายชือ่นี้ 

filename: 

คน้หาวา่มกีารแนบไฟลด์ว้ยชือ่หรอื

ประเภทไฟลน์ีห้รอืเปลา่ 

Example -

 filename:physicshomework.txt 
Meaning – ขอ้ความทีม่กีารแนบไฟล์
ดว้ยชือ่ "physicshomework.txt" 

Example - label:work filename:pdf 
Meaning – ขอ้ความใน label "work" 

ทีม่ไีฟลป์ระเภท PDF แนบอยู ่

" " 
(quotes) 

ใชส้ าหรับคน้หาวล*ีนัน้ๆโดยเฉพาะ  
 
 

 
 

*จะตัวใหญ่ตัวเล็กกไ็ด ้

Example - "i'm feeling lucky" 
Meaning – ขอ้ความทีม่วีล ี"i'm 
feeling lucky" หรอื "I'm feeling 

lucky" 
Example - subject:"dinner and a 
movie" 

Meaning – ขอ้ความทีม่วีล ี"dinner 
and a movie" ใน subject 

( ) 

ใชส้ าหรับตอ้งการรวมกลุม่ค า  
ใชใ้นการระบุ terms ทีไ่มต่อ้งการให ้

หายไป 

Example - from:amy(dinner OR 
movie) 

Meaning – ขอ้ความจาก Amy ทีม่ทีัง้
ค าวา่ "dinner" หรอืค าวา่ "movie" 
Example - subject:(dinner movie) 

Meaning – ขอ้ความใน Subject ทีม่ี
ทัง้ค าวา่ "dinner" และค าวา่ "movie" 

in:anywhere 

คน้หาส าหรับขอ้ความทกุทีใ่นGmail* 
 

*รวมถงึขอ้ความใน 
Spam และ Trash  

Example - in:anywhere movie  
Meaning – ขอ้ความทัง้หมดใน 

Mail, Spam, และ Trash ทีม่คี าวา่ 
"movie" 

in:inbox 
in:trash 

in:spam 

คน้หาขอ้ความใน Inbox, Trash, or 
Spam 

Example - in:trash from:amy 
Meaning - ขอ้ความจาก Amy ทีอ่ยูใ่น

Trash 

is:starred 
is:unread 

is:read 

คน้หาขอ้ความทีเ่ป็น starred, 
unread หรอื read 

Example - is:read is:starred 
from:David 
Meaning - ขอ้ความจาก David ทีอ่า่น

แลว้ และมกีารมารค์เครือ่งหมาย star 

cc: 
bcc: 

ใชร้ะบผุูรั้บเฉพาะเจาะจงใน
การ cc: หรอื bcc:* 

*การคน้หาใน bcc: ไมส่ามารถท าได ้

Example - cc:david  
Meaning - ขอ้ความทีถ่กู cc-ไปยงั 
David 
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after: 
before: 

คน้หาขอ้ความทีถ่กูสง่ระหวา่ง

ชว่งเวลานัน้ๆ * 
*วันจะตอ้งอยูใ่นรปูแบบ 
yyyy/mm/dd เทา่นัน้. 

Example - after:2004/04/16 

before:2004/04/18  
Meaning – ขอ้ความทีส่ง่ระหวา่ง 
April 16, 2004 และ April 18, 

2004.* 
*โดยสามารถระบใุหล้ะเอยีด: 
Messages sent after 12:00 AM (or 

00:00) April 16, 2004 and before 
April 18, 2004. 

is:chat 

คน้หาส าหรับขอ้ความในแชท็ Example - is:chat monkey 

Meaning – ทกุๆchat message ทีม่ี
ค าวา่ "monkey". 

deliveredto: 

คน้หาขอ้ความโดยเฉพาะทีใ่ช ้email 
address ในการสง่ในหัวขอ้ความ 

Example -
 deliveredto:username@gmail.com 

Meaning – ทกุขอ้ความทีใ่ช ้
username@gmail.com ในการสง่ไป
ยังทกุๆหัวขอ้ความ  

 

Search autofill  

 ตรงชอ่ง Search Mail นัน้มฟัีงกช์นัทีเ่รยีกวา่ Search autofill ซึง่ชว่ยใหเ้ราคน้หาไดง้่าย
ขึน้ดังนี ้

มขีอ้มลูที ่recommened 

 

 

เพยีงคณุเลอืก has เราสามารถคน้หาไดข้อ้ความทีม่กีารแนบไฟล ์ภาพ เอกสาร วดิโีอ 

หรอืปฏทินิได ้หรอืจะระบชุือ่ประเภทของไฟลก์็ยงัได ้

http://2.bp.blogspot.com/_JE4qNpFW6Yk/SdPaI5sVgLI/AAAAAAAAATE/8LhNAnuAAxg/s1600-h/search_autocomplete_contacts.jpg
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การสรา้ง Task  

 เป็นการตดิตามกระบวนการของภารกจิหรอืงานทีส่ าคัญ เพือ่ใหรู้ว้า่มกีารตอบกลับหรอืวา่

ยอมรับหรอืยัง 

● การสรา้ง Tasks สามารถท าไดโ้ดย เปิดเมลท์ีต่อ้งการสรา้ง Task คลกิ More actions> 
Add to Tasks จากภาพจะเห็นวา่มกีารสบัสนเรือ่งนัดหมายส าคัญ ซึง่หากมกีารท าเป็น 
Task จะชว่ยใหเ้ราตดิตามนัดหมายนัน้ไดอ้ยา่งรวดเร็ว 

 

http://2.bp.blogspot.com/_JE4qNpFW6Yk/SdPaYcyvF5I/AAAAAAAAATM/IHbB2KV72Hw/s1600-h/search_autocomplete_operators.jpg
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/1-3/moreactions_addtotasks-1.jpg?attredirects=0


Copyright © 2012 by Google Apps Supporting Program  Page 36 
 

การสรา้งและจดัระเบยีบ multiple task lists  

 หากเราม ีTask ทีต่อ้งท ามากมายเราสามารถยอมรับ และปฏเิสธ Task นัน้ได ้โดยคลกิ 
More ดังภาพ 

 

เราสามารถก าหนดไดว้า่ Task ไหนทีไ่ดรั้บการยนิยอมแลว้อันไหนยังไมผ่่านได ้

 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/2-1/moving tasks -step 1.jpg?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/2-1/movetolist.jpg?attredirects=0
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การสรา้ง task list ใหมส่ามารถท าไดโ้ดย: 
1. คลกิ Tasks ทางดา้นซา้ยของ Apps mail  
2. คลกิปุ่ ม 'list'  

3. เลอืก 'New list' 
4. กรอกชือ่ new list และกด OK. 

 

 

การพมิพ ์และสง่ Task ใหก้บัคนอืน่  
บางครัง้คณุตอ้งการสง่ Task list ทีค่ณุสรา้งไปบอกคนในทมีวา่ Tasks ทีม่คีวามจ าเป็น

นัน้มอีะไรบา้งทีต่อ้งท าเพือ่ใหโ้ปรเจ็คสมบรูณ์ 

 
การสง่ email ทีม่ ีtask list ท าไดโ้ดย: 

1. เปิด Tasks จากทางดา้นซา้ยของหนา้ตา่ง Apps mail  

2. คลกิ Actions และเลอืก 'Email task list' ตามภาพ 

 

 

 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/2-1/newlist-1.jpg?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/3-2/email task list.jpg?attredirects=0
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การเชือ่มตอ่ Task กบั Google Calendar 

สามารถท าไดด้ังนี ้

1. คลกิดังภาพ 

 

2. คลกิสญัลักษณ ์Calendar 

 

 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/4-1/with date for calendar - step 1.jpg?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/4-1/calendar step 2.jpg?attredirects=0
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เพยีงเทา่นี้คณุก็สามารถเชือ่มตอ่ Task กับ Calendar ไดแ้ลว้ 

 

 

 

 

 

Google Calendar 

Google Calendar เป็นการท างานแบบเว็บจะชว่ยใหเ้รา และเพือ่นรว่มงานสามารถท างาน

รว่มกันไดอ้ยา่งมปีระสทิธภิาพ 

ก าหนดการนดัหมายอยา่งงา่ยดาย 

http://edutraining.googleapps.com/Training-Home/module-2-mail/chapter-6/4-1/calendar final step-1.jpg?attredirects=0
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วางปฏทินิหลายรายการซอ้นกันเพือ่ดวูา่ใครวา่งเมือ่ใด Google ปฏทินิจะสง่ค าเชญิและจัดการ

การตอบกลับ 

ท างานรว่มกบัระบบอเีมล ์ 

มกีารผสานรวม Google ปฏทินิ เขา้กบั Gmail และท างานรว่มกับแอปพลเิคชนัปฏทินิทีไ่ดรั้บ

ความนยิม 

แบง่ปันปฏทินิโครงการ 

คณุสามารถแบง่ปันปฏทินิใหก้บัทัง้บรษัิท หรอืกบัเพือ่นรว่มงานทีเ่ลอืกไว ้การควบคมุสทิธิก์าร

แบง่ปันขอ้มลูทีม่มีากมายจะชว่ยรักษาความปลอดภัยและความเป็นสว่นตัว 

เขา้ถงึจากโทรศพัทม์อืถอื 

ดแูละแกไ้ขรายละเอยีดกจิกรรม เพิม่กจิกรรมใหม ่และเชญิผูเ้ขา้รว่มจากทางโทรศัพทม์อืถอื 

เชน่ BlackBerry และ iPhone รวมทัง้รับขอ้ความแจง้เตอืนของปฏทินิผ่าน SMS 

ท าปฏทินิใหเ้ป็น Public  

แสดงกจิกรรมภายนอกของบรษัิทสูส่าธารณชนดว้ยการเผยแพรป่ฏทินิเพือ่ใหส้ามารถคน้หาได ้

ในแกลเลอรขีอง Google ปฏทินิ ซึง่จะสามารถฝังปฏทินิลงในหนา้เว็บไดอ้ยา่งง่ายดาย 

 

 

 

 

 

http://www.google.com/url?q=http://img.skitch.com/20091108-jx9ju94ga4mwxjhc4uh1rhr8mi.jpg&sa=D&sntz=1&usg=AFrqEzeNM2gmwuXJsg7lUA9ZJc2tfpFX1w
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การเปิด Calendar  

การเปิดด ูGoogle Calendar ของเราสามารถท าไดห้ลายวธิ ี 

แบบที ่1  

1. เปิดจากมมุซา้ยบนของกหนา้ Google Apps  
2. คลิ๊กเลอืก Calendar  

 
 

3. Google Calendar จะถกูเปิดในหนา้ตา่งใหม ่ 

  
 
 

http://www.google.com/url?q=http://img.skitch.com/20091108-rkem952w1drgspxeh5umambu1j.jpg&sa=D&sntz=1&usg=AFrqEzdphADqKj3zSBQsd1-wRZLea_krtg
http://www.google.com/url?q=http://img.skitch.com/20091108-cisby6aw61j2am8uwch4nenx4k.jpg&sa=D&sntz=1&usg=AFrqEzf1bNJFF2GyX8UAuqDS99CaqUx-8g


Copyright © 2012 by Google Apps Supporting Program  Page 42 
 

หรอืจะเปิดผ่าน URL ก็ได ้ซึง่กค็อื calendar.google.com/a/yourcompany.com 

 

การเพิม่ตารางนดัหมาย และ สรา้ง Events 

แบบที1่  

1) คลิ๊กทีปุ่่ ม Create ตรงแถบซา้ยมอื 

 

 

2) พบหนา้ตา่งใหม ่เพือ่กรอกขอ้มลูตารางนัดหมาย  
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แบบที ่2  

หรอื จะไปเลอืกวันบนปฏทินิ โดยการ 

1) คลิ๊กเลอืกวันทีเ่ราตอ้งการสรา้ง event  

  

 

2. ในชอ่งทีเ่ขยีนวา่ What ใหใ้สข่อ้มลูการนัดหมายสัน้ๆ ไว ้เชน่ Meeting with ABCD 
Company และกด Create event เป็นการเสร็จสิน้  

 
 

2) Event นัน้จะไปปรากฏอยูบ่นปฏทินิของคณุ  
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แบบที ่3  
อกีหนึง่วธิทีีค่ณุสามารถสรา้งปฏทินิไดค้อื การใช ้Quick Add  

 
 

ในกรณีใช ้Quick add ควรพยายามทีจ่ะตอ้งบอกวา่ การนัดหมายนัน้เกีย่วกบัอะไร, เมือ่ไร , กับ
ใคร , และ ทีไ่หน 

เชน่ Meeting with Dan 10AM Friday at Four Seasons Hotel  

 

 

 

คลิ๊ก Add จะพบวา่เครือ่งมอืนี้จะชว่ยเลอืกใหว้า่ Meeting with Dan 10AM Friday at Four 
Seasons Hotel , Bangkok จะมขี ึน้ในวันศกุรท์ีใ่กลท้ีส่ดุ และadd อัตโนมัตทินัท ี 

http://img.skitch.com/20101029-ew19nxm48p7futh9ijt3rqs335.jpg
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เมือ่ไปคลิ๊กดขูอ้มลูเพิม่เตมิ เครือ่งมอืนี้จะยังเชือ่มตอ่ไปยงั Google Maps เพือ่บอกอกีวา่ทีนั่ด
หมายที ่Four Seasons Hotel, Bangkok นัน้อยูท่ีไ่หน  

 

ถา้เราตอ้งการจะดแูผนทีข่อง Four Seasons Hotel, Bangkok ก็คลิ๊กลงิค ์Map ก็จะปรากฏ
หนา้ Google Map ของFour Seasons Hotel Bangkok ขึน้มา 
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การเพิม่ปฏทินิเวลาทีจ่ะมกีารเกดิขึน้ซ า้ๆ  

1) เปิดหนา้ Event นัน้ขึน้มา 

 

 

2) คลิ๊กที ่Repeat  
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3) จะเกดิกลอ่ง Repeat ป็อปอัพขึน้มา ใหก้รอกขอ้มลูดังนี้  

 

 ในหนา้นี้ใหเ้ราเลอืกวา่จะให ้event นี้เกดิซ ้าในลักษณะใด เชน่ ทกุๆสปัดาห ์

เชน่ทกุๆวันจันทร ์เราจะเลอืกที ่M ซึง่หมายถงึ Monday  
 Starts on : หมายถงึเริม่ตัง้แตวั่นทีเ่ทา่ใด  

 Ends : หมายถงึจะการตัง้คา่ event นี้ท าซ ้าไปมาจนถงึเมือ่ไร  

 Never จะหมายถงึวา่ให ้event นี้ลงในปฏทินิของเราไปเรือ่ยๆ  
 After …………………Occurrences หมายถงึใหห้ยดุเมือ่ม ีevent นี้เป็น

จ านวน …………ครัง้  
 On…………………….หมายถงึใหส้ ิน้สดุในวันที…่……………………….. 

 คลิ๊กที ่Done เมือ่เลอืกเรยีบรอ้ยแลว้ ในปฏทินิจะปรากฏขอ้มลูตารางนัดหมาย
ตามทีเ่ราเลอืก คอื Repeat: Weekly on Monday  

  



Copyright © 2012 by Google Apps Supporting Program  Page 48 
 

การเพิม่ขอ้มลูลงในปฏทินิ โดยสามารถเพิม่ไดห้ลากหลาย  

 

 

 Where : ใสส่ถานทีล่งไป 

 Description : ใสร่ายละเอยีดเกีย่วกับ event นัน้ๆ  
 Attachment : add attachment เมือ่เรามขีอ้มลูทีต่อ้งใชใ้นการดเูพิม่เตมิ 

เชน่ Agenda งานนัน้ๆ ไฟลนั์น้อาจจะอยูใ่น Google Docs ของเราอยูแ่ลว้  
 ถา้เรามกีารแชร ์Event นี้ใหก้บั Guest คนอืน่ๆ เราตอ้งตรวจสอบดวูา่ เอกสารใน 

Google Docs ทีเ่ราแนบไวน้ีไ้ดม้กีารอนุญาตให ้Guest เหลา่นัน้สามารถเขา้ถงึ
เอกสารได ้ 
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นอกจากนัน้เรายังสามารถทีจ่ะเลอืก Event color เพือ่ทีจ่ะสรา้งความแตกตา่งของ 
Event นัน้ๆไดด้ว้ย  

Reminders: เราสามารถเลอืกการแจง้เตอืนไดถ้งึ 3 แบบ คอื  

1) การสง่ Email แจง้เตอืน 
2) Pop-up ขึน้มาทีห่นา้จอ  
3) สง่ SMS มาทีม่อืถอืของเรา (เราตอ้งมกีารตดิตัง้เบอรม์อืถอื กับอเีมลน์ีก้อ่น)  

 

 

การ Pop-up ขึน้มาทีห่นา้จอจะขึน้มาเป็นดงัภาพ 

การสรา้ง Multi Calendar  

Google Calendar จะอนุญาตใหเ้ราม ีปฏทินิหลายๆ อัน เราอาจจะมปีฏทินิเรือ่ง งาน, สว่นตัว, 
กฬีา เราสามารถเลอืกทีจ่ะใส ่event ของเราในปฏทินิอันไหนก็ได ้เชน่ เราอาจจะเลอืกevent ที่

เกีย่วกับ Meeting ไวใ้นปฏทินิงาน(work) และ event ทีเ่กีย่วกับ การประชมุผูป้กครอง ไปไวใ้น
ปฏทินิสว่นตัว(Personal) ซึง่ปฏทินิทีโ่ชวก์็สามารถแยกแยะดว้ยสสีนัทีแ่ตกตา่งกนั ท าใหเ้รา

สามารถบรหิารจัดการเวลาไดม้ปีระสทิธภิาพยิง่ข ึน้  
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ในการสรา้ง Multi Calendar สามารถท าไดโ้ดยการ  

1. เลอืกที ่My Calendar คลิ๊กทีปุ่่ ม drop down  

 

 

2. ใหเ้ลอืกค าวา่ Create new calendar  

3. เกดิหนา้ Page “Create Calendar” ขึน้เพือ่ใสข่อ้มลู  

Calendar Name : ใหใ้สช่ือ่ปฏทินิลงไป เชน่ Personal เพือ่เป็นการระบวุา่เป็นปฏทินิสว่นตัว

ของเรา  
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Description       : ใหร้ายละเอยีดเพิม่เตมิเกีย่วกบัปฏทินินี้ สามารถเวน้วา่งไวไ้ด ้ 

Location           : เลอืก Bangkok อันนี้จะเป็นประโยชน์ส าหรับถา้เราแชรป์ฏทินิของเราเป็น
ลักษณะ Public  

Calendar Time Zone: เลอืก Thailand time zone อันนีจ้ะส าคัญมาก เพราะบางทเีราอาจจะมี
การนัดหมายกับคนตา่งชาตทิีอ่ยูค่นละ Time Zone กัน  

Now select a time zone: เลอืก GMT +7.00 Bangkok  

 

 

 

และในสว่นขา้งลา่งจะมใีหเ้ราเลอืกวา่ จะ Share this calendar with others ในชอ่งนี้จะ
หมายถงึวา่ เราะจะเลอืก วา่เราจะแชรป์ฏทินิอันนี้กบัคนอืน่หรอืเปลา่  
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ถา้เราตอ้งการใหท้กุคนในองคก์รของเราเห็นปฏทินิของเรา เพีอ่ทีท่มีงานจะไดรั้บทราบถงึวา่เรา

วา่งหรอืไมว่า่งในชว่งนัน้ ใหเ้ราเลอืกค าวา่  

Share this calendar with everyone in this organization และเลอืกที ่drop down 

ลงมาวา่ให ้ 

See all event details: หมายถงึ ทกุคนในองคก์รจะเห็นตารางนัดหมาย และรายละเอยีด

ตารางนัดของเราทัง้หมด  

See only free/busy (hide details): หมายถงึ ทกุคนในองคก์รเราจะเหน็เฉพาะวา่

ชว่งเวลานัน้ๆของปฏทินิเราจะ free หรอื busy ซึง่คนอืน่จะไมเ่หน็รายละเอยีดตารางนัดของเรา  

 

นอกจากนัน้เรายังสามารถเลอืกทีจ่ะ Share with specific people คอื เลอืกทีจ่ะแชรเ์ฉพาะ

บางคนเทา่นัน้ โดยเราสามารถใสอ่เีมลข์องคนทีเ่ราตัองการจะแชรแ์ละกด Add People ก็จะท า
ใหค้นทีเ่ราแชรไ์ปสามารถเลอืกดปูฏทินิได ้ 

          

การเลอืกใชป้ฏทินิ Multi Calendar  

 เมือ่เรามปีฏทินิหลายๆอนัแลว้ เชน่ Work, Personal, Sport เวลาทีเ่ราสรา้ง Event จะ
ใหเ้ลอืกวา่ Event นัน้ๆ อยูใ่นปฏทินิแบบไหนของเรา  

 ในขัน้ตอนของการทีเ่ราสรา้ง Event จะมใีหเ้ราเลอืกวา่ Calendar: และม ีdrop down 

ใหเ้ลอืก เชน่ การ Meeting with Sam ซึง่เป็นลกูคา้ ก็จัดสรรใหอ้ยูใ่น ปฏทินิ Work ของเรา  
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 เมือ่เราคลิ๊กเลอืก Create Event: Meeting with Sam จะไปปรากฏอยูใ่นวันทีเ่ราเลอืก
ไวค้อื Tue, Feb 21, 10.30-11.30 และจะไปอยูใ่นปฏทินิ Work ของเรา ซึง่เป็นสฟ้ีาดังภาพ 
ซึง่จะชว่ยใหเ้ราเห็นภาพของตารางงานเราไดช้ดัเจนยิง่ข ึน้  
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Practices Google Calendar  

1) ใหส้รา้งปฏทินิแบบ Multi Calendar ขึน้มา 3 แบบคอื Work , Personal, Sport  

โดยใหเ้ลอืกแชรป์ฏทินิ Work ใหก้ับคนในองคก์รใหค้นในองคก์รเห็นแบบ Detail  

และทีจ่ะไมแ่ชรป์ฏทินิ Personal ใหก้ับใครเลย  

และเลอืกทีจ่ะแชรป์ฏทินิ Sport ใหเ้ป็น Public  

2) สรา้ง Event ในปฏทินินัน้ ๆ ดงันี ้ 

 Team Meeting: ใหส้รา้งปฏทินินี้ เป็นแบบ Repeat ทกุๆ วันจันทรเ์วลา 8.30-

9.30 โดยใหอ้ยูใ่นปฏทินิแบบ Work 
 VAT Payment Preparation: ใหส้รา้งปฏทินินี้เป็นแบบ Repeat ทกุๆวันที ่15 

ของทกุเดอืนเวลา 9.00-10.00  
 Kid’s homework: ใหส้รา้งปฏทินินี้เป็นแบบ Repeat ทกุๆวันจันทร ์– ศกุร ์เวลา 

19.00-20.00 โดยใหอ้ยูใ่นปฏทินิแบบ Personal  

 Badminton lesson: ใหส้รา้งปฏทินินี้เป็นแบบ Repeat ทกุๆ วันเสารเ์วลา 
19.00 – 20.00 โดยใหอ้ยูใ่นปฏทินิแบบ Sport  

การเพิม่การ Reminder ผา่นทาง SMS 

กอ่นทีเ่ราจะสามารถตัง้การแจง้เตอืน Reminder ผ่าน SMS ไดเ้ราตอ้งตดิตัง้มอืถอืเราใหผู้กกับ
อเีมลข์องเรากอ่นดังนี้  

● เขา้ทีไ่ปทีห่นา้ Calendar  
● เลอืกทีปุ่่ มเครือ่งมอืทีเ่ป็นรปู Gear และเลอืก Calendar Setting  

 

 

● เลอืกเมนูทีเ่รยีกวา่ Mobile Setup  
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● เลอืก Country: Thailand  
● กรอกเบอรโ์ทรศัพท ์Phone number : กรอกหมายเลขโทรศัพทม์อืถอืของเรา  

● กดทีปุ่่ ม Send Verification Codeเพือ่ใหร้ะบบสง่ Verification Code มาทีม่อืถอืของเรา  

 

● เชค็ขอ้ความในมอืถอืของเราจะพบวา่มขีอ้ความแจง้ Verification code กลับมา  
● Your Google Calendar verification code is xxxxxx.  

 

● ใหเ้ราน า Code นัน้มาใสใ่นกลอ่งขอ้ความ Verification code และกดปุ่ ม Finish setup  
● สกัพักก็จะไดรั้บขอ้ความสง่มาวา่ Your device at +6681xxxxxxx has been verified. 

To stop visit google.com/calendar แสดงวา่เราไดผู้กเบอรม์อืถอืของเรากับ Google 
Apps account ของเราแลว้  

● ตอ่ไปเราก็สามารถทีจ่ะตัง้ Notification หรอื reminder ใหเ้ป็น SMS ไดด้ังนี ้ 

● ไปทีเ่มนู My Calendars > ที ่Drop down ใหเ้ลอืก Settings    
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● Calendar Settings > คลิ๊กเลอืก Notifications ของปฏทินิของเราแตล่ะอัน   

 

 

 

● กดเลอืก Notification ของปฏทินิ Work  
● ในชอ่ง Event reminders ใหเ้ราเลอืกการเตอืน  

● By default, reminder me via  

Email 10 minutes before each event : หมายถงึใหเ้ตอืนเราลว่งหนา้กอ่นจะถงึเวลาของ

แตล่ะ event 10 นาท ี

 

เราสามารถทีเ่ลอืกที ่Drop down menu เป็น SMS แจง้เตอืนกอ่นevent 10 นาท ี 
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● ถา้เราไมต่อ้งการเราก็กด Remove เพือ่ยกเลกิการตัง้คา่แจง้เตอืนนี้  

 

หมายเหต ุ: เมือ่คณุเปลีย่นแปลง reminder setting ส าหรับ events บนปฏทินิของคณุ การ
เปลีย่นแปลงตา่งๆ ของ reminder setting จะเปลีย่นเฉพาะคณุเทา่นัน้ guest ทีไ่ดรั้บเชญิเขา้

รว่ม event นัน้ๆ จะไดรั้บการแจง้เตอืนตามทีเ่คา้ setting ตัว Google Calendar reminder 
settings เทา่นัน้  

 

การต ัง้คา่ปฏทินิโดยท ัว่ไป  

1) My calendar > Settings > General  

 

 

 

http://www.google.com/url?q=http://img.skitch.com/20091116-d3i1aex3k193r1xet3yjr1t28r.jpg&sa=D&sntz=1&usg=AFrqEzdleKm0sa4bRBX1VwmmBTfP2JTOBw
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2) เลอืกขอ้มลูใหถ้กูตอ้ง  

Languages : เลอืก English หรอื ภาษาไทย หรอื ภาษาอืน่ๆ ตามทีเ่ราถนัด  

Country : เลอืก Thailand  

Your current time zone : ถา้ปกตอิยูท่ีเ่มอืงไทยใหเ้ลอืก GMT+7.00 Bangkok  

ส าหรับคนทีต่ดิตอ่กบัชาวตา่งชาตบิอ่ย อาจจะเลอืก Timezone มากกวา่ 1 อัน เพือ่ทีจ่ะไดรั้บวา่
เวลาทีเ่รานัดหมายประชมุกับลกูคา้ตา่งชาตนัิน้เป็นเวลากีโ่มง เชน่กรณีนีเ้ลอืก timezone : 
GMT+7 Bangkok พรอ้มกับ GMT-5 Eastern Time-Toronto 

 

เมือ่ตัง้ Current time zone หลายอัน ปฏทินิของคณุก็จะมเีวลาทีเ่พิม่ข ึน้มาดังนี ้จะท าใหเ้รา

สงัเกตไดว้า่เวลาทีเ่รานัดหมายนัน้เป็นเวลากีโ่มงของเคา้ ดงัภาพ 

 

 

แบง่ปนัปฏทินิกบัคนอืน่ๆ  
1) Edit event > Add Guest  
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. 
 

2) ในสว่นทีเ่ป็น Add Guests section ใหค้ลิ๊กลงิคท์ีเ่ป็น Guests   
3) ใส ่Email Address ของ Guests โดยใชเ้ครือ่งหมายคอมมา่ “,” ในการแบง่แตล่ะอเีมล ์ 
4) ใตก้ลอ่งขอ้ความนัน้คณุจะสงัเกตเห็นวา่คณุสามารถเลอืก การใหส้ทิธขิอง guest แตล่ะ

คนดังนี ้
 

○ Modify the event: สามารถเปลีย่นแปลงแกไ้ข event ได ้ 

○ Invite others: สามารถเชญิ guest คนอืน่เพิม่เตมิได ้ 
○ See the guest list: สามารถเห็นไดว้า่ม ีguest คนไหนมารว่มงาน หรอืไม่

มารว่มงานบา้ง  

 

5) คลิ๊กที ่Save เพือ่บนัทกึการตัง้คา่ 

 

http://edutraining.googleapps.com/Training-Home/module-3-calendar/chapter-3/1-2/editdetails.jpg?attredirects=0
http://img.skitch.com/20101029-d2m5jdaxcnxp8mmdp8wwb9ys4.jpg
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การเชญิคนทีไ่มไ่ดใ้ช ้Google Calendar แลว้ใหเ้คา้ตอบกลบั 

เราสามารถเชญิใครก็ตามทีไ่มไ่ดใ้ช ้Google Calendar ตราบใดทีเ่คา้ม ีEmail address เมือ่
คนๆนัน้ไดรั้บจดหมายเชญิจาก Google Calendar เคา้สามารถตอบกลับวา่สามารถเขา้รว่มได ้

หรอืไม ่ตามลงิคท์ีส่ง่ไปจาก Google Calendar ของเรา  

1) เมือ่ Guest ไดรั้บ Google Calendar invitation แลว้ เขาเหลา่นัน้จะไดรั้บอเีมลแ์จง้

เกีย่วกับ Event name, วันและเวลา, สถานที ่และขอ้มลูเพิม่เตมิทีผู่เ้ชญิสง่ไปให ้ 

2) ในอเีมลฉ์บับนัน้จะมลีงิคท์ีใ่หผู้รั้บเชญิสามารถ RSVP เพือ่ทีจ่ะบอกวา่  

Yes: เขา้รว่ม, NO: ไมเ่ขา้รว่ม , Maybe: อาจจะเขา้รว่มหรอืไมเ่ขา้รว่ม  

และยังมชีอ่งใหก้รอก Comment ส าหรับ Status ทีต่อบกลบัมา  

 

การเพิม่ปฏทินิของเพือ่นรว่มงาน  

หลายๆครัง้เราอยากรูว้า่เพือ่นรว่มงาน เจา้นายวา่งเวลาไหนบา้ง จะไดนั้ดประชมุไดถ้กูตอ้งถกู

เวลา เราสามารถเพิม่ปฏทินิของเพือ่นรว่มงานได ้โดยการขอใหเ้คา้แชรป์ฏทินิของเคา้กับเรา  

1. ทีด่า้นบนของรายการปฏทินิทางซา้ย ใหค้ลกิปุ่ มลกูศรลง add และเลอืก add friend 

calendar  

2. ป้อนทีอ่ยูอ่เีมลทีเ่หมาะสมในชอ่งทีม่ใีห ้จากนัน้คลกิ add  

ถา้เพือ่นของคณุไดเ้ลอืกทีจ่ะแบง่ปันปฏทินิของตนแบบสาธารณะ ปฏทินิก็จะปรากฏใต ้Other 

Calendar ในคอลัมน์ทางซา้ย มฉิะนัน้ คณุจะพบขอ้ความขอใหค้ณุเขา้ถงึปฏทินิของเพือ่น 

คณุสามารถเพิม่ขอ้ความในค าขอนี้ จากนัน้คลกิ Send request  

ถา้คณุไมพ่บปฏทินิของเพือ่น คณุสามารถขอใหเ้พือ่นสง่ค าเชญิถงึคณุ โดยใหเ้พือ่นท าตาม

ขัน้ตอนตอ่ไปนี้เมือ่ลงชือ่เขา้ใช ้Google ปฏทินิของตน: 
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1. ในรายการ My calendar ทางซา้ย ใหค้ลกิปุ่ มลกูศรชีล้งถัดจากปฏทินิทีต่อ้งการ 

จากนัน้เลอืก Share this calendar 

2. ในสว่น Share to specifi person ใหป้้อนทีอ่ยูอ่เีมลของบคุคลทีค่ณุตอ้งการแบง่ปัน

ปฏทินิดว้ยภายในฟิลดท์ีม่ใีห ้เลอืกระดับสทิธิท์ีต่อ้งการ และคลกิ add user  

 

Google Docs 

Google docs มหีลายประเภททัง้ text documents, spreadsheets, presentations, 

drawings, and forms โดยมขีอ้ดหีลายๆ อยา่งทีจ่ะชว่ยใหค้ณุท างานไดอ้ยา่งมปีระสทิธภิาพ

มากขึน้  

 

1) ท างานรว่มกนัได ้และ แชรเ์อกสารใหเ้พือ่น 

คณุสามารถร่วมกันท าเอกสาร กับเพือ่นรว่มงานของคณุ โดยทีไ่มจ่ าเป็นตอ้งอยูใ่นทีท่ี่

เดยีวกัน จะแก ้Document หรอื Presentation ก็ท างานไดพ้รอ้มๆ กนัเลยทเีดยีว  

2) จดัเก็บงานของคณุไดอ้ยา่งปลอดภยั 

อปุกรณ์เก็บขอ้มลูแบบออนไลนแ์ละการบันทกึอัตโนมัตชิว่ยใหค้ณุไมต่อ้งกังวลเรือ่ง

ฮารด์ไดรฟ์เสยีหรอืไฟดบั 

3) บนัทกึและสง่ออกส าเนาไดอ้ยา่งงา่ยดาย 

คณุสามารถบันทกึเอกสารและสเปรดชตีของคณุไปยังเครือ่งคอมพวิเตอรข์องคณุเองใน

รปูแบบ DOC, XLS, CSV, ODS, ODT, PDF, RTF และ HTML ได ้

4) เขา้ถงึจากทีไ่หนก็ได ้

ไมต่อ้งมกีารดาวน์โหลดสิง่ใด คณุสามารถเขา้ถงึเอกสาร สเปรดชตี และงานน าเสนอ

ของคณุไดจ้ากคอมพวิเตอรเ์ครือ่งใดก็ไดท้ีม่กีารเชือ่มตอ่อนิเทอรเ์น็ตและมเีบราวเ์ซอร์

มาตรฐาน โดยไมม่คีา่ใชจ้่ายใดๆ 

5) จดัระเบยีบเอกสาร 

คน้หาเอกสารของคณุไดอ้ยา่งง่ายดายดว้ยการจัดระเบยีบเอกสารในโฟลเดอรต์า่งๆ ลาก

และวางเอกสารตา่งๆ ของคณุลงในหลายโฟลเดอรไ์ดต้ามทีค่ณุตอ้งการ 
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การเริม่ใชง้าน Google Docs  
 

1)   เขา้ไปที ่Google docs โดยตรง โดยใส ่ 

https://docs.google.com/a/your_domain.com ในเบราเซอรข์องคณุ

(อยา่ลมืเปลีย่น your_domain.com เป็นโดเมนของคณุเอง) หรอื เขา้ไปที ่

Docs.google.com และใส ่user name , password ของคณุลงไป  

 

2) หรอืเขา้ใชง้านทาง Google appsอืน่ๆ เวลาคณุใช ้Google Apps คณุจะเหน็รายการ

Google apps อืน่ๆทีด่า้นบนซา้ยของหนา้.ใหค้ลกิที ่ Documents เพือ่เขา้ใชง้าน 

Docs ของคณุ 

 

 
 

การสรา้งเอกสาร 
1) จากรายการ Docs ของคณุ ใหค้ลกิที ่Create และเลอืก Document 

https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
https://docs.google.com/a/your_domain.com
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2) จากนัน้จะมเีอกสารทีไ่มม่ชี ือ่ปรากฏขึน้--ตอนนี้คณุสามารถแกไ้ขหรอืจัดการเอกสารของ

คณุไดแ้ลว้ 

 

 

การเปลีย่นชือ่เอกสาร 
คลิ๊กทีช่ ือ่ของเอกสารเพือ่เปลีย่นมนั(ชือ่เอกสารตอนทีเ่พิง่สรา้งคอื “Untitled document”) 

 
 

Format ท ัว่ๆไปใน Google Docs 
สามารถเลอืกทีจ่ะ Undo, redo, and paint format ได ้ 

 

 

 

การแกข้อ้ความใน Google Docs จะคลา้ยๆกับ การใช ้word processing software เพราะ

สไตลข์อง Toolbar menu ทีอ่ยูบ่นเอกสารก็จะคลา้ยๆกัน  
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การเปลีย่นฟอนต ์หรอืขนาดของตัวอักษร ท าไดง้่ายๆ เพยีงแคค่ลิ๊กตรง Drop down menu ลง

มาและคลิ๊กเลอืก ปกตแิลว้มันจะตัง้คา่เป็น Arial ไซต ์11pt  

 

สามารถทีจ่ะท าตัวหนา ตัวเอยีง ขดีเสน้ใตไ้ด ้รวมถงึเปลีย่นสฟ้ีอนต ์และไฮไลทต์ัวอักษรได ้

พรอ้มทัง้ยังสามารถใส ่Hyperlink ไดด้ว้ย  

 

 

 

การใสล่งิคใ์หเ้ราเลอืกตรงขอ้ความหรอืรปูภาพทีเ่ราตอ้งการท าใหเ้ป็นlink และกดทีเ่มนูทีเ่ป็น

รปูโซ ่ 

 

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-3/4-1/heading styles.jpg?attredirects=0
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และจะเกดิกลอ่งขอ้ความ เพือ่ใหก้รอกขอ้มลูเว็บไซตท์ีเ่ราตอ้งการสรา้งลงิคไ์ปสู ่… 

ใหเ้ราพมิพ ์url ของเว็บไซต ์และกด OK  

 

เราจะได ้Link ส าหรับขอ้ความนัน้ดงันี้ ซ ึง่เราสามารถทีจ่ะแกไ้ข หรอื ลบลงิคนั์น้ไดต้ลอดเวลา 

เพยีงน าcurser ไปวางไวใ้กล ้ๆ ขอ้ความนัน้ ก็จะปรากฏหนา้ตา่งเล็กๆ ใหค้ลิ๊กที ่Change เพือ่

แกไ้ข หรอื remove เพือ่ลบลงิคนั์น้  
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Format ตา่งๆ บน Tool bars 

 

 

File  

 

Share… ใชเ้พือ่แชรเ์อกสารนี้  

 

New : เพือ่สรา้งเอกสารใหม ่

 

Open : เพือ่เปิดเอกสาร  

 

Rename : เปลีย่นชือ่เอกสาร 

 

Make a copy : เพือ่สรา้ง copy 

ของเอกสารนัน้  

 

See revision history : เพือ่ดู

ประวัตกิารแกไ้ขเอกสาร  

 

Language : เลอืกภาษา 

 

Download as : เพือ่ทีจ่ะดาวน์

โหลดเอกสารฉบับนี้ ซ ึง่สามารถ 

download เป็น format ตา่งๆ 

เชน่ PDF, DOC  

 

Publish to the Web : เพือ่ท าให ้

เอกสารนี้เปิดเป็น publish  
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Email collaborators : เพือ่ทีจ่ะ

สง่เมลแ์ชรเ์อกสารฉบับนี้ใหผู้อ้ ืน่ , 

คนทีจ่ะชว่ยกันแกไ้ข หรอืรวีวิ

เอกสารฉบับนี้รว่มกัน  

 

Email as attachment : เพือ่สง่

อเีมล ์โดยแนบไฟลเ์อกสารฉบับนี ้

โดยเราสามารถเลอืกวา่จะใหแ้นบ

ไฟลเ์ป็นลักษณะใด เชน่ HTML, 

Word  

 

Page setup : การจัดหนา้  

 

Print : เพือ่สัง่พมิพเ์อกสารฉบับนี ้ 
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Insert 

 

Image : แทรกภาพ 

Link : เพิม่ลงิค ์

Equation : ใสส่ตูรทางคณติศาสตร ์ 

Drawing : ใสก่ารวาดรปู เชน่ วงกลม ,

สีเ่หลีย่มตา่งๆ  

Comment : เพิม่คอมเมน้ต ์

Footnote : ท า footnote  

Special Characters : เพิม่ตัวอักษรทีพ่เิศษ 

Horizontal line : เพิม่เสน้แนวนอน  

Page number : เพิม่เลขหนา้ 

Page count : นับจ านวนหนา้  

Page break : ขึน้หนา้ใหม ่ 

Header : สรา้ง Header  

Footer : สรา้ง Footer  

Bookmark : ท าบุ๊คมารค์  

Table of contents : สรา้งสารบัญ  
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การแชรเ์อกสารใน Google Docs  
การแชรเ์อกสารจะชว่ยใหค้ณุสามารถท างานกับเพือ่นรว่มงานของคณุบนเอกสารไดพ้รอ้มๆกัน

ถงึ 50 คน  

การแชรเ์อกสารสามารถแชรไ์ด ้3 รปูแบบคอื  

 เลอืกแชรเ์ฉพาะคน เพยีงใส ่email address ของคนๆนัน้  

 เลอืกแชรใ์หก้บัคนทีไ่ดรั้บ link นี้  

 เลอืกแชรเ์ป็นลักษณะ Public คอื เปิดใหก้ับทกุๆคนสามารถดไูด ้ 

เราสามารถทีจ่ะตรวจสอบดวูา่เอกสารเราตอนนี้ไดแ้ชรใ์หใ้ครบา้ง โดยการน าเมาทไ์ปวางไวบ้น

ปุ่ ม Share สฟ้ีาบนมมุขวาของเอกสารของคณุ  

ถา้พบวา่ Private to only me แสดงวา่ เอกสารนี้ยังไมไ่ดท้ าการแชรใ์หก้ับใครเลย  

 

 

Format  

 

Bold : ท าตัวหนา 

Italic : ตัวเอยีง 

Underline : ขดีเสน้ใต ้ 

Strikethrough : ขดีฆา่ 

Superscript : ยกก าลัง 

Subscript : เลขหอ้ยขา้งลา่ง 

Paragraph styles : จัด paragraph  

Align : การจัดหนา้ 

Line space : ความหา่งระหวา่งบรรทัด 

List styles : การท าลสิต ์เชน่ การท า bullet 

Clear formatting : ลา้ง format  
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การแชรแ์บบใหเ้ฉพาะคนทีไ่ดร้บัลงิคน์ี ้(Anyone with the link)  

คนทีไ่ดรั้บเอกสารการแชรแ์บบนี้จะเปิดดไูดก้็ตอ่เมือ่ไดรั้บลงิคท์ีถ่กูตอ้งมาเทา่นัน้ ก็จะเหมาะ

ส าหรับการแชรแ์บบตอ้งการใหค้นมากๆดไูด ้ เชน่ อาจารยต์อ้งการแชรเ์นื้อหาวชิาเรยีนครา่วๆ 

และหนังสอืทีต่อ้งอา่นใหก้ับนักศกึษากลุม่นัน้ อาจารยส์ามารถเลอืกทีจ่ะใชว้ธิกีารนี้ และสง่ลงิค์

นี้ใหก้บันักศกึษา  

แชรแ์บบเป็น Public บนเว็บไซต ์(Public on the web) 

เป็นการเลอืกไวส้ าหรับเอกสารทีค่ณุตอ้งการทีจ่ะใหค้นมาดไูด ้และสามารถ Search เจอ เชน่ 

เอกสารการตลาด โบรชวัรง์านละครเวท ี 

วธิกีารแชร ์ 

น าเมาทไ์ปวางทีปุ่่ ม Share และคลิ๊กเพือ่เลอืกวา่ตอ้งการทีจ่ะแชรแ์บบไหน  

 

เราสามารถเลอืกคนทีเ่ราแชรใ์หเ้ป็น  
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 Is owner: เป็นเจา้ของเอกสาร มสีทิธิส์งูสดุในเอกสารนัน้  

 Can edit: สามารถแกไ้ขเอกสารได ้

 Can comment: สามารถใหค้อมเมน้ตบ์นเอกสารได ้

 Can view: ดเูอกสารไดอ้ยา่งเดยีว ไมส่ามารถแกไ้ข หรอื comment เพิม่เตมิใดๆได ้ 

Comment Feature ใน Google Docs  
Comment feature จะชว่ยใหค้ณุท างานบนเอกสารกับเพือ่นรว่มงานของคณุไดด้ขี ึน้ โดยที ่

Docs Stamps ทีอ่ยูใ่นคอมเมน้ตจ์ะบอกวา่ ใครเป็นคนใหค้อมเมน้ตนั์น้ และเมือ่เวลากีโ่มงของ

วันทีเ่ทา่ใด  

คอมเมน้ตท์ีป่รากฏอยูจ่ะอยูบ่นเอกสารนัน้ๆ แตจ่ะไมป่รากฏเมือ่เราท าการสัง่พมิพ ์ 

 

 

การต ัง้การแจง้เตอืน เมือ่มคีนคอมเมน้ตใ์น Google Docs  
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1) คลิ๊กที ่Comment ทีม่มุขวาบนของเอกสาร > Notification Settings 

 

 

 

 

 

2) เลอืกการ setting ดังนี ้ 

 Don’t send me any email notifications for this doc (not recommend) 

ไมใ่หส้ง่การแจง้เตอืนมาเลย ซึง่ไมแ่นะน า เพราะเราจะไมรู่ไ้ดเ้ลยวา่มใีครเขยีน คอม

เมน้ตอ์ะไรใหเ้ราในเอกสารบา้ง 

 Enable email notifications for this document’s threads สง่การแจง้เตอืน

มายังอเีมล ์ 

 Notify me of all new comments and replies on this document: เลอืกขอ้

นี้เมือ่เราตอ้งการไดรั้บทกุๆ คอมเมน้ตบ์นเอกสารฉบบันี้  

 Notify me of replies to my comments: เลอืกขอ้นี้เมือ่เราตอ้งการไดรั้บการแจง้ 

เมือ่มคีนมาเขยีนใตค้อมเมน้ตข์องเรา  
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 Notify me of replies to threads that I have commented on : เลอืกขอ้นี้

เมือ่เราตอ้งการไดรั้บการแจง้เตอืน เมือ่คนมาตอบกลับในสิง่ทีค่ณุไดค้อมเมน้ตล์งไป  

 Notify me when I am @mentioned in a comment: เลอืกขอ้นี้เมือ่เรา

ตอ้งการไดรั้บการแจง้เตอืน เมือ่คนคอมเมน้ตเ์ลอืกทีจ่ะใช ้@mentioned ชือ่ของคณุใน

คอมเมน้ตด์ังกลา่ว  

 

การเลอืกใช ้Template บน Google Docs  
1) ใหเ้ขา้ไปที ่File > New > from template… หรอื เขา้ไปที ่

https://docs.google.com/templates 
 

 

 

2) จะปรากฏหนา้ตา่ง ใหเ้ลอืก template ทีเ่ราตอ้งการโดยการคลิ๊กที ่Use this template  

 

https://docs.google.com/templates
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การแปลเอกสารดว้ย Function การ Translate บน Google 

Docs  
เราสามารถแปลเอกสารทัง้หนา้ได ้แตต่อ้งยอมรับวา่ภาษาทีแ่ปลจะใช ้Google Translate การ

แปลจะไมส่มบรูณ์แบบ เพราะเป็นเพยีงการแปลครา่วๆ ดว้ย Google Translate  

1) เปิดเอกสารนัน้ขึน้มา  
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2) Click ที ่Tools > Translate document  

 

3) เลอืกภาษาทีเ่ราตอ้งการ  
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4) Google docs จะท าการแปล ไปทีห่นา้ใหมข่องเรา 

Google Docs บนมอืถอื    
 เขา้ไปที ่Browser บนมอืถอืเรา และเขา้สู ่docs.google.com 

 คณุสามารถแกไ้ขขอ้มลูบน Google Docs ผ่านมอืถอืได ้ดไูดจ้ากขอ้มลูขา้งลา่งนี้ 

(UPDATE 10 มนีาคม 2555)  
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Google Spreadsheet 

การใชง้านจะเหมอืนๆ กับ Google Docs สามารถแชร ์และท างานรว่มกับผูอ้ ืน่ๆ ได ้ 

Advance format ใน Google Spreadsheet 

การประมวลขอ้มลูดว้ย Pivot table ใน Google Spreadsheet 

1) เปิดหนา้ขอ้มลูทีอ่ยูใ่น Spreadsheet 
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มขีอ้มลูดงันี้ Student Name, Gender, Class level, Home State, Major, Extracurricular 

Activity  

เพือ่ทีจ่ะท ารายงานสรปุวา่ มนัีกเรยีนแตล่ะชัน้ปีกีค่น และแตล่ะชัน้ปีแบง่เป็นผูห้ญงิ และ ผูช้ายกี่

คน  

1) Data > Pivot table report…  
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2) จากตัวอยา่ง Spreadsheet นี้เราตอ้งการท ารายงานสรปุว ่มนัีกเรยีนแตล่ะชัน้ปี ทีเ่ป็น

ผูห้ญงิ และ ผูช้าย กีค่น  

 Rows- Add field : เลอืก Gender  

 Columns –Add field : เลอืก Class Level  

 Values-Add field: เลอืก Class Level , Summarize by : COUNTA 

 

 

การสรา้ง Chart จากขอ้มลู 

1) Insert > Chart  
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2) คลิ๊กเลอืก Switch rows/columns เมือ่เราตอ้งการสลับระหวา่ง rows กับ column เพือ่

การสรา้ง Chart  

3) คลิ๊กเลอืก Use column A as headers เมือ่เราตอ้งการใหข้อ้ความใน Column A เป็น 

Header ใน Chart  

 

เลอืกแบบ Chart > Column เพือ่ท าใหเ้ป็นกราฟแทง่  
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4) เลอืกทีป่รับรายละเอยีดของ Chart โดยคลิ๊กทีปุ่่ ม Customize > Title > ขอ้มลู

นักศกึษาปี 1-4 [หัวขอ้ของ Chart] > Update 
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5) ถงึตอนนีเ้ราก็ไดข้อ้มลู พรอ้ม chart เพือ่ใชใ้นการ Present เป็นทีเ่รยีบรอ้ยแลว้ เรา

สามารถทีเ่ลอืกทีจ่ะน า Chart บันทกึเป็น Image หรอื copy chart ไปไวท้ีอ่ ืน่ 

 

 

6) สามารถทีจ่ะแกไ้ข Chart นี้ไดต้ลอดเวลา โดยการคลิ๊กที ่Edit Chart…  
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Google Presentation  

การสรา้ง Presentation ดว้ย Template 
1) Create > Presentation  

2) Choose a theme > เลอืก Theme > Update  
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การสรา้ง Animation  
1) View > Animations 

 



Copyright © 2012 by Google Apps Supporting Program  Page 87 
 

 

 

2) เกดิ Box ทางขวามอื ดงันี ้ 

 

 

ใหเ้ลอืก animations ทีต่อ้งการ  
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เชน่ เลอืก Slide from left : เพือ่ให ้slide ปรากฏมาจากทางดา้นซา้ย  

 

 

3) สามารถเลอืกจะใหท้กุๆ slide ม ีanimations แบบเดยีวกันดว้ยการคลิ๊ก Apply to all 

slides และ กด Play เพือ่ทดลอง animations ทีเ่พิง่ใสเ่ขา้ไป  

 

การใช ้Google Presentation ในการพรเีซนตง์านจรงิๆ 
คลิ๊กที ่Start Presentation และก็เริม่ไดท้นัท ี 

 

 

 

 

 

 

Google Forms 
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สามารถท าแบบสอบถามง่าย ๆทีด่แูลว้เป็นมอือาชพีผ่าน Google Forms ซึง่มขีอ้ดอียูห่ลายๆ

อยา่ง  

1) Template อยูถ่งึ 60 template และก็มรีปูแบบค าถามถงึ 7 แบบ  

2) จากเก็บขอ้มลูเรยีบรอ้ยแลว้ ขอ้มลูจะไดรั้บการสรปุอยูใ่น Google Spreadsheet 

3) เราสามารถน าขอ้มลูเหลา่นัน้ไปท าเป็น Chart เป็น Graphs ทีเ่ราตอ้งการไดอ้ยา่ง

ง่ายดาย  

 

รปูแบบของ Form ท ัง้ 7 แบบ (ดงัภาพ)  

I. Drop-down lists with options 
II. Single line text box 

III. Multiple choice 
IV. Scale, to ask your invitees to grade something in a scale from 1-5, for 

instance. 

V. Checkboxes 
VI. Paragraph text, which allow for long answers 

VII. Grid 

 

 

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/2-2/Exampleofallquestiontypes.png?attredirects=0
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การสรา้ง Form  
Create > Form  

 

 

 

การสรา้ง Form จาก Spreadsheet ทีม่อียูแ่ลว้  
File > New > Form  
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การต ัง้ชือ่ Form  
 ตัง้ชือ่ Form โดยการคลิ๊กทีค่ าวา่ Untitled form เพือ่เปลีย่นเป็นชือ่ทีเ่ราตอ้งการ  

 เขยีนค าบรรยายสัน้ๆเกีย่วกับ Form ทีเ่ราสรา้งขึน้มา  

 

 

การเลอืก Theme ของ Form  
1) คลิ๊กที ่Theme ทีม่มุบนซา้ย ของฟอรม์ทีเ่ราสรา้ง  
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2) เลอืก Theme ทีต่อ้งการ > Apply  

 

 

สญัลกัษณก์ารแกไ้ข หรอื ลบค าถาม หรอื สรา้งค าถามทีม่รีปูแบบ

เหมอืนๆกนั  

   

Edit: เพือ่ทีจ่ะแกไ้ข
ค าถามปัจจุบัน  

Delete: เพือ่ทีจ่ะลบ
ค าถามนัน้ๆ . 
 

Duplicate: เพือ่ทีจ่ะสรา้งค าถามทีม่ี
ลักษณะเหมอืนๆ กนั . 

 

การเพิม่ค าถาม  
Add item > เลอืกรปูแบบค าถามทีเ่ราตอ้งการ  
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เราสามารถเลอืกทีจ่ะใหค้ าถามนัน้เป็นค าถามทีท่กุคนตอ้งตอบโดยการคลิ๊กเลอืกที ่Make this 

a required question 

 

การจดัหนา้ของค าถามใน Form   
เราสามารถ drag ค าถามขึน้ลงตามทีเ่ราตอ้งการได ้ 

 

 

การแกไ้ขค า confirmation  
1) ไปทีเ่มนู More action > Edit confirmation  

 

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/2-3/Question types-1.jpg?attredirects=0
https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/2-4/drag and drop questions.jpg?attredirects=0
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2) แกไ้ขขอ้มลู > save  

 

การสง่อเีมลถ์งึผูท้ ีเ่ราตอ้งการใหต้อบ Form  
 

Email this form > ใสอ่เีมลท์ีค่ณุตอ้งการสง่ถงึ  

 

หมายเหต ุคณุสามารถใชป้ระโยชน์จาก Groups in Google Apps or Google Groups เพือ่ทีจ่ะ

สง่ form นี้ไปยงัเพือ่นรว่มงาน เพือ่นนักเรยีนของคณุ 

 

การ embed form ลงในเว็บไซต ์
More actions > embed 

 

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/2-6/Edit confirmation.jpg?attredirects=0
https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/2-6/edit confirmation-1.jpg?attredirects=0
https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/3-1/email form.png?attredirects=0
https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/3-3/Embed from more actions.jpg?attredirects=0
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การอนุญาตใหผู้ต้อบ form สามารถเขา้มาแกไ้ขค าตอบได ้ 
บนมมุซา้ยดา้นบน ของ form จะมใีหเ้ราเลอืกวา่ allow users to edit responses ใหเ้ราเลอืก

ปุ่ มนี้ ก็จะท าใหผู้ต้อบสามารถ edit response ได ้ โดยคลิ๊กที ่Edit your response (ดังภาพ)  

 

 

 

 

 

การดขูอ้มลูสรปุใน spreadsheet  
  

See responses> spreadsheet  

 

 

 

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/4-1/See response spreadsheet.jpg?attredirects=0
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การดขูอ้มลูสรปุทีเ่ป็น Chart  
 

See response > summary  

 

 

 

 

Google Sites 

เราสามารถสรา้งเว็บไซตง์่ายๆโดยไมจ่ าเป็นตอ้งรูเ้รือ่ง programming ใดๆเลย ขอ้ดหีลายๆ

อยา่งของ Google Sites คอื  

1) ใช ้Google Sites เพือ่รวมเอกสาร สเปรดชตี งานน าเสนอ วดิโีอ ภาพสไลด ์และอกี

มากมายไวท้ีศ่นูยก์ลาง เพือ่ชว่ยใหท้มีท างานอยา่งเป็นระเบยีบ  

2) มเีทมเพลตหลากหลาย  

https://sites.google.com/a/googleapps.com/edu-training-center/Training-Home/module-4-docs/chapter-6/4-3/summary response.jpg?attredirects=0
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3) เขา้ถงึไดท้กุที ่ทกุเวลา  

4) ท างานไดใ้นหลายระบบปฏบิัตกิาร  Google Sites ท างานในเบราวเ์ซอรบ์นคอมพวิเตอร ์

PC, Mac และ Linux  

5) การควบคมุการรักษาความปลอดภัยของระบบและระดับเว็บไซต ์โดยผูด้แูลระบบ

สามารถจัดการสทิธิก์ารแบง่ปันไซตใ์หก้บัทัง้ธรุกจิ และผูเ้ขยีนสามารถแบง่ปันและ

ยกเลกิการเขา้ถงึไฟลเ์มือ่ใดกไ็ด ้ 

 

การสรา้ง  Google site  
1) Site > Create  

 

2) เลอืกขอ้มลูตา่งๆ เชน่ Blank template หรอื Browse the gallery template  

 

https://sites.google.com/a/googleapps.com/edu-training-center/config/pagetemplates/module-5-template/sites link.png?attredirects=0
http://edutraining.googleapps.com/Training-Home/module-5-sites/chapter-2/1-2/create site basics.png?attredirects=0
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3) ตัง้ชือ่ site และ URL (ไดเ้ฉพาะ A-Z, a-z, 0-9) 

4) เลอืก Theme  

5)  More options เพือ่ใสข่อ้มลูของ  

a. Site categories  

b. Site description  

c. การตัง้การแชรเ์ว็บไซต ์ 

 

6) Create site  

การ Manage Site  
การจัดการเว็บไซต ์ใหเ้ขา้ไปทีเ่ขา้ไปเลอืกที ่More > Manage site  

 

 

 

http://edutraining.googleapps.com/Training-Home/module-5-sites/chapter-2/1-3/more options.png?attredirects=0
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เมือ่เขา้ไปทีห่นา้ Manage site คณุสามารถทีจ่ะแกไ้ข site ไดท้ัง้หมด เชน่ การ sharing and 

permission, Page template, Colors and fonts , attachment, Apps script , site layouts  
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…………………………………………………………… 

 

 

 

 

 

 

 

 

 

 


